[ronPython Tools for Visual Studio
Walkthrough

IronPython Tools for Visual Studio provides Python programmers with a great development experience
inside of Visual Studio. IronPython Tools for Visual Studio (IronPython Tools for short) is a set of
components that extends Visual Studio. It supports editing, debugging, creating Python projects, and
participating in VS solutions.

At this time, IronPython Tools is just a prototype. We are handing it out to a few customers to get
feedback. This walkthrough takes you on a tour of features to familiarize you with the IronPython Tools
Prototype. Feedback about IronPython Tools can be reported publicly to the IronPython Mailing List or

privately to ironpy@microsoft.com.

Installation

IronPython Tools for Visual Studio installs as a Visual Studio extension (VSIX). To use IronPython Tools
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free integrated shell or with the Professional, Premium, or Ultimate editions. L ¥ & 2dz R2y QG | f NB |
Visual Studio 2010 installed you can download the integrated shell or a free trial edition.

Once Visual Studio is installed you can double click IronPythonTools.vsix to install the extension into
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Studio and start editing some Python code!

Getting Started

Upon starting Visual Studio you can either proceed with or without a project file, while still getting code
analysis over related code. To start working with a project you can choose New Project from the start
page or File->New Project. Select the appropriate project type and select a location to create the
project. For more information about the project types see the Projects section below.

To start working without a project you can just open any .py files using File->Open. IronPython Tools
provides completion, parameter tips, go to definition, etc., on all the code in the directory containing
the file you opened, as well as sub directories.

Projects
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IronPython Tools supports the Visual Studio project system. Project files for IronPython are .pyproj
files. Like all Visual Studio languages, Python project files are referenced from a solution which can

contain one or more project files from varying languages.
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Projects include a start-up file which is the file that runs when you =
start with debugging or execute your project in the interactive -4 Solution 'MyConsoleApplication
window. This file is indicated by the green play button on the file 4 (2] MyConsoleApplication

icon. You can change this file either by right clicking and selecting dl References
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IronPython Tools includes 4 project types:

Console Application
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a console window for input and output. If you use Execute in IronPython Interactive, input and output

occur in the interactive as if it were a console window. NOTE: in the prototype release, there is a bug,

and input does not work.

IronPython Silverlight Web Page

This is an IronPython application which will run in the web browser using Silverlight. Your script code is
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boilerplate script tag pulls down some JavaScript code which initializes IronPython running inside of

Silverlight. From there your Python code can interact with the DOM.

WPF Application
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window and includes a template which creates a Windows Presentation Foundation application. The

code and design are separated with the markup being stored in a .XAML file. There is a WYSIWIG

designer which enables drag and drop editing of the design. Python code can be used to wire up event

handling.

WinForms Application
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window. A typical usage of this is to start a WinForms application. IronPython Tools currently does not
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logic to create the Ul in Python (see the IronPython tutorial for examples).

Lightweight Usage Project-free
IronPython Tools also supports editing your code without a project system. You can open any files on
disk and start editing them. IronPython Tools will automatically include other files and packages in the
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create a project file.

The Editor

One of the primary experiences when working with IronPython Tools is of course editing the source
code. IronPython Tools includes syntax color highlighting, outlining of classes and functions, and drop
down navigation. There is an analysis engine that understands your classes and functions using type
inference. This enables you to receive member completion and signature help, receive tool tips when
hovering over source code, and quickly navigate and find references within your source code.

Intellisense
Some of the primary features of the editor are support for rich member completion, signature help, and

quick info when hovering over members. Supporting this is a new analysis engine which infers types
def f{abc):
return abc

from their usage to provide useful

information to the developer. The
f('hello world").|

type inference is control flow
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 center independent and works across
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@ encode boundaries and is updated in real
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IronPython Tools also is able to
provide significant intellisense against standard Python built-in functions and .NET classes by relying
upon the strong typing available for .NET members. To IronPython range(5).ap|
Tools these are both identical problems ¢ so the same great : E‘PPE:" * | append(sel, object item) |
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from sys import | inside of a module. In this
=l api_version “ . . . .
& afg; example you can also see that the intellisense engine is aware of
¢ arg
“%¢ builtin_module_names the members and also of the types of members, so you get a
= byteorder quick visual clue o
W callstats for persocn, age, height in people:
% call_tracing for the member print persen.|
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These are all fairly simple examples so far, but the analysis engine is capable of some sophisticated
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iterate over those lists or index into them using global constants. The analysis engine is capable of
tracking the types of indices and providing intellisense on a per-index basis.

{2 FIN 6SQ@FS 2dzad o6SSy GlFf1Ay3 o2dzi YSY0OSNI O2YLX
offer more information than just that. One common form of additional information is signature help.

-ldef fia, b =42, c = "hi'):
"""documentation™""

Here IronPython Tools captures any relevant doc strings from the function
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fla, b=42, c="hi) to iterate through the available overloads using the arrow keys. Of course,

documentation
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correct function based upon the number of parameters.
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as a value. IronPython Tools provides rich information about what an expression can possibly represent
when you hover over it.

def failIfEqual(self, first, second, msg=None):

"""Fail if t
operator.

selfi TestCase instance, FunctionTestCase instance, Testinstance

if first == second:
raise self.failureException, \
(msg or '¥r == ¥r' % (first, second))
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present.
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Go To Definition
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del Find All References Ctrl+kK, R

1mpo Breakpoint 8

= Run To Cursor Ctrl+ F10

One very handy tool when looking at source code is to be oM endtoInteractive Ctrl+E, E
able to quickly navigate to a function definition from a caller ~ —3l Send to Defining Module Cirl+E M
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IronPython Tools will analyze what the current expression is, - Oel.llljning = ,

and if the expression resolves to a single function,
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IronPython Tools immediately navigates to that function. If there are multiple definitions, the tool
displays choices in the Find Symbol Results window, where you can double click on any definition to

navigate to it.

Find All References

Another useful tool when refactoring or working with a large code base is to find all the references to a

Jdef warnpy3k(message, category=None, stacklewvel=1'

I @ GoTo Definition
Warn Find All References
o Breakpoint
if s

S Run To Cursor
Send to Interactive
Send to Defining Module
idef _shg ¥ cut
if § = Copy
y Paste
try:
r'y Outlining

Fi2
Ctrl+K, R

Ctrl+F10
Ctrl+E, E
Ctrl+E, M
Ctrl+X
Ctrl+C
Ctrl+V
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function or a class. IronPython Tools provides this
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References or via the Shift-F12 hot key. Based upon the

analysis of the code, all of the known references will be

displayed in the Find Symbol Results along with the line of

code where the reference appears. You can then double

click on each line to immediately navigate to the nearest

reference.

Find Syrbaol Results - 30 matches found
ZP C:\Program Files\IronPython 2.6\Lib\audicdev.py - (3, 1): warnpy3k("the audicdev module has been rem
2P C:\Program Files\IronPython 2.6'\Lib\Bastion.py - (29, 1): warnpy3k("the Bastion module has been remov
=P C\Program Files\TronPython 2.6\Lik\commands.py - (67, 5): warnpy3k("In 3., mk2arg has been remover
=4l C:\Program Files\TronPython 2.6\Lib\commands.py - (81, 5): warnpy3k("in 3., mkarg has been removed.
2P C:\Program Files\IronPython 2.6\Lib\dircache.py - (7, 1): warnpy3k("the dircache module has been remo)
2P C:\Program Files\IronPython 2.6\Lib\fpformat.py - (14, 1): warnpy3k{"the fpformat module has been rem
&P C\Program Files\IronPython 2.6\Lib\htmllib.py - (8, 1): warnpy3k{"the htmllib medule has been remove
Zp C\Program Files\IronPython 2.8\Lib\ihooks.py - (53, 1): warnpy3k("the ihooks module has been remove
Zp C\Program Files\IronPython 2.8\Lib\imputil.py - (13, 1): warnpy3k("the imputil module has been remowe
Zp C\Program Files\IronPython 2.8\Lib\macpath.py - (173, 5): warnings.warnpy3k{"In 3.x, os.path.walk is rer
2P C:\Program Files\IronPython 2.6\Lib\mhlib.py - (56, 1): warnpy3k("the mhlib module has been removed |

= C:\Proaram Files\IronPvthon 2,64 Lib\mimetools,oy - (14, 11: warnov3k("in 3.x. mimetools has been remor
e

Working with the Interactive Window

IronPython Tools for Visual Studio includes an interactive window for developing your code ¢ commonly
called a REPL (Read/Evaluate/Print/Loop). The interactive window supports executing files or the start
file of your project. The text of the menu item will change depending on if you have a project opened or
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Debug | Team Data

4
I

Tools  Architecture Test

Windows

Start Debugging

Start Without Debugging

Execute Project in IronPython Interactive
Start Performance Analysis

Attach to Process...

Exceptions...

Analyze

Window| Debug | Team Data Tools Architecture Test Analyze Wi
[ Windows 4
F5 P Start Debugging F3
Ctrl+F5 > Start Without Debugging Ctrl+F5
Shift+Alt+F5 K  Execute File in IronPython Interactive Shift+Alt+F5
Alt+F2 | kA Start Performance Analysis Alt+F2
|5k  Attach to Process...
Ctrl+D, E Exceptions... Ctrl+D, E

You can also bring up the interactive window without executing any code with the Tools->Other
Windows->lronPython Interactive menu item (or Alt-1). This opens the interactive window if it is not
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or for other interactive development, the contents will still be available for your perusal:

IronPython Interactive

hella

b

File scope:  __rnain__

» print 'hells'

'n}(

"

- % 4

Switching Scopes

The interactive window when initially started is in the scope for the __main__ module. If you bring up

File scope:

»

IronPython Interactive

» impor

* O X

K H

__main__|
stat

b

linecache
o3.path
wwarnings
genericpath
abc
UserDict
types
__rmain_

0s

m

executes in that module.

_abcall

Whenever you p

any actions such as switching scopes, a log

message is written in the output window, so you

the interactive window without starting a file, the module is

empty. If you start a file or your project, the module contents

is the starting file, as if you ran it from the command prompt.

You can also view other scopes which contain user code and

switch amongst them to execute code within those modules.
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execute, and you can now switch between them using the

File Scope drop down.

Selecting a module changes the current scope, and input now
erform

IranPython Interactive

File scope:  ntpath = x &

-
» -
»
» import os B
Current scope changed to ntpath
» dir()
["_all_ ", '__builtins_ ', '__doc_ ",
' file ', '__name_ ', '_ package_ ', =

'_getfullpathname', 'abspath', "altsep’,
"basename’, 'commonprefix’, 'curdir’,
"defpath’, ‘'devnull', ‘dirname’, ‘exists’,

LINBS



IranPython Interactive

File scape: UserDict = 3% 49y X

» ¥mod UserDict
Current scope changed to UserDict

» dir()

['DictMixin®, 'IterableUserDict’, 'UserDict’,
' builtins__ ", '_doc_ ', '_ file_ ',
'_name__ ', ' package_ ', '_abcell']

»

-

your development.

can keep track of how you got to a certain state during

The interactive window also supports several meta
commands. All meta commands start with a %, and
you can type % or %help to get a list of the meta

commands. The most useful meta command is probably the command that switches between modules

without using the drop down box. This command is the %mod command and is followed by the module

yIYS

@ 2 dzQ Rh tb. DtheS corinindsinglddé cl@aring the screen, running a file which can

include % commands as well, or resetting the interactive process. The commands are also extensible via
MEF (the Managed Extensibility Framework for .NET).

The interactive window includes intellisense based on the live objects rather than by analyzing the
source code. This differs from the editor buffers of .py files in that analysis of the code in the REPL
window is not necessary. The benefits are that you always get good completion. . The drawback here is

that functions which have side effects may impact your development experience. To control this

behavior there are few

>Qptions->Editor-
Here you can choose to

IranPython Interactive

File scope: o: = 38 & &

» import ntpath
» ntpath.abspath(|

evaluate expressions
evaluate expressions. In

ntpath.abspath(path)
Return the absclute version of a path.

mode the normal
for discovering possible

*0OXx

evaluate expressi2 Y a
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member accesses are unlikely to have side effects. Finally always evaluate expressions will execute the

expression to get completion information regardless of the expression

Sending Code to Interactive

In addition to working within the
interactive window there are
commands available that send selected
from the editor to the interactive
window. This lets you work within the
interactive window, update code in the
editor, and then quickly send the
updated code to the interactive
window.

print 'Hello World'
print 'goodbye world’

¥
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g

Go To Definition
Find All References

Show Calling Tests

Run Calling Tests
Breakpoint

Run To Cursar

Send to Interactive

Send to Defining Module
Cut

Copy
Paste

Outlining

different options in the Tools-

>lronPython->Advanced menu.

never evaluate expressions, never

containing calls, or always

the never evaluate expressions

intellisense engine will be used

.| completions. In the never
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F12 code
Ctrl+K, R

Ctrl+F10
Ctrl+E, E
Ctrl+E, M
Ctrl+X
Ctrl+C
Ctrl+V



In addition to simply sending the code to the current scope in the interactive window there is

class classi: also a separate command which sends the code to the
i {8 GoTo Definition F12 defining module. This command will search the interactive
Find All References Cirl+K R process to find the module that matches the current file
Hemor Elimy = being edited. If the command finds the correct module,
Run Calling Tests . .
: then it uses the %module command to switch to that
Breakpoint 4
_ module. The %module command becomes part of the
*=  Run To Cursor Ctrl+F10 . . . . . .
o to et o history of the interactive window so that the interactive
Send to Defining Module Chrl+E, M buffer remains as a comprehensive history of everything

@ 2 dzQ @ SThdr the/cEntthand pastes the selection into
the interactive window for evaluation.

The end result of this in the interactive window is indistinguishable from if you had manually switched to
the correct scope and pasted the text yourself:

#» Bmodule classl
Current scope changed te classl
# class classl:

""rdescription of class"""

The Object Browser

When a project is loaded, IronPython Tools supports using the Object Browser for viewing classes
defined in each module and the functions defined in those classes. The left hand pane of the Object
Browser enables you to view all of the modules defined and drill down into them. As you do so, the
right hand side updates to reflect the current class you are browsing, and the bottom right hand pane
will show you any information about the method currently selected on the right hand side.



Object Broweser ¢

O stdlib - Microsoft Visual Studic
File  Edit “iew Project Build Debug  Tools

Windoaw  Help

[E=N(ECR ™
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Brovse: |My Solution

o e = |53

- ¢t turtlepy
» v types.py
+ 42 undefined.py
» ¢2 unicode_escapepy
» ¢ unicode_internal.py
4 % unittest.py
“I% FunctionTestCase
K
“i% TestCase
“I% TestLoader
“i% TestProgram
“I% TestResult
“I% TestSuite
“1% _TextTestResult
“I% TextTestRunner
“I% _WritelnDecorator
+ ¢t unixccompiler.py
+ ¢2f upload.py
+ ¢ urllib.py
» g2t urllib2.py
» g2t urlparse.py

W __call__(self, *args, ““lwds)
4w countTestCases(self)

v debug(self)

9 defaultTestResult(self)

W __eq_(self, other)

W _exc_info(self)

W fail(self, msg = Mone)

W faillf(self, expr, msg = None)

W faillfAlmostEqual(self, first, second, places = 7, msg = None)

¥ faillfEqual(self, first, second,

£

(2

m

W failUnless(self, expr, msg = None)
W failUnlessAlmostEqual(self, first, second, places = 7, msg = Mone)
“ failUnlessEqual(self, first, second, msg = None)

v failUnlessRaises(self, excClass, callableDhj, *args, *“kwargs)

“9 __hash__(self)
W id(self)

4| i

def failUnless(self, expr, msg = None)
Fail the test unless the expression is true.

Debugging

IronPython Tools currently supports debugging using the .NET debugger and normal Visual Studio

debugging support. This enables you to start your program under the

debugger, set break points, step through functions, change the current
statement, inspect local variables, and perform other operations that you

are used to while debugging.

Prograrm.py 3

“gC
[+ print 'Hello World®

—lclass C(object):
] def _ init_ (self):
self.abc = 42
| def f(self):
print "abc’

Sdef f(x):

(] print x.f()
return x

o (ci))




Currently debugging in IronPython Tools is primarily handled by the C# expression evaluator, so you will
not get an extremely Pythonic experience.

Meme Value : However, you will be able to accomplish
i@ ffunction function "t in "_main_"
I @ "_rain_C instance" basic debugging tasks. For example when
# @ .class PythonType: "C" . . .
—¢ dict dict Literns broken into a Python function you will be
@ abe 4 able to inspect local variables, including
+ @ Raw View L .
T @ R Yiew those pointing to instances of Python
@ slats_and_weakref null classes. When drilling into these objects,
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and instance variables. This is currently a fairly primitive experience but is better than needing to

explicitly dig into the IronPython data structures themselves to inspect classes. In future releases of

IronPython Tools we will improve this experience so it reflects what the Python programmer would

expect to see.



